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Introduzione

Avviso importante

 Il contenuto di questo documento e le specifiche di questo prodotto sono soggetti a modifiche senza 
preavviso.

 Brother si riserva il diritto di apportare modifiche senza preavviso alle specifiche e ai materiali qui contenuti 
e non potrà essere in alcun modo ritenuta responsabile di eventuali danni (inclusi quelli indiretti) causati 
dall'affidamento riposto nei materiali presentati, inclusi, a titolo esemplificativo ma non esaustivo, gli errori 
tipografici e di altro tipo eventualmente contenuti nelle pubblicazioni.

 Le immagini delle schermate riportate in questo documento possono differire a seconda del sistema 
operativo del computer, del modello del prodotto e della versione del software.

 Prima di utilizzare la stampante di etichette, accertarsi di leggere tutta la documentazione fornita con 
la stessa, per informazioni sulla sicurezza e sull'utilizzo corretto.

 La stampante mostrata nelle illustrazioni potrebbe essere diversa dalla stampante in uso.

 Le forniture disponibili possono variare a seconda del paese.

Manuali disponibili

Per scaricare le più recenti versioni dei manuali, visitare il sito Web di supporto Brother all'indirizzo 
support.brother.com e fare clic su Manuali.

1 Manuale stampato nella confezione.
2 Manuale PDF sul sito Web di supporto Brother.

Guida di sicurezza prodotto 1 Questa guida fornisce informazioni sulla sicurezza; è necessario 
leggerla prima di utilizzare la stampante.

Guida di installazione rapida 1 Questa guida fornisce le informazioni di base sull'uso della 
stampante.

Guida dell'utente 2 Questa guida fornisce ulteriori informazioni sulle impostazioni 
e le operazioni della stampante, suggerimenti sulla soluzione dei 
problemi e istruzioni per la manutenzione.

http://support.brother.com/
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Simboli usati in questa guida

Nella presente guida sono utilizzati i seguenti simboli:

Indica una situazione potenzialmente pericolosa che, se il prodotto viene utilizzato 
senza attenersi alle avvertenze e alle istruzioni, potrebbe provocare la morte 
o gravi lesioni.

Indica una situazione potenzialmente pericolosa che, se non viene evitata, 
potrebbe provocare lesioni di piccola o moderata entità.

IMPORTANTE Indica informazioni o istruzioni da seguire. Il mancato rispetto di tali istruzioni può 
causare danni o malfunzionamenti.

Nota Indica informazioni o istruzioni utili per comprendere e utilizzare il prodotto in modo 
più efficiente.

AVVERTENZA

ATTENZIONE
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Precauzioni generali
Rotolo DK (etichetta DK e nastro DK)

 Usare solo accessori e materiali di consumo originali Brother (con i simboli  e ). NON utilizzare 
accessori o materiali di consumo non autorizzati.

 Se l'etichetta viene applicata a una superficie bagnata, sporca o oleosa, potrebbe staccarsi facilmente. 
Prima di applicare l'etichetta, pulire la superficie sulla quale essa verrà attaccata.

 I rotoli DK utilizzano carta o pellicola termica che può scolorirsi o attaccarsi alle superfici, se esposta 
a luce ultravioletta, vento o pioggia.

 Non esporre i rotoli DK alla luce solare diretta, a temperature o umidità elevate o a polvere. Riporlo in un 
luogo fresco e buio. Utilizzare i rotoli DK subito dopo aver aperto la confezione che li contiene.

 Se si graffia con le dita od oggetti metallici la superficie stampata dell'etichetta, oppure se la si tocca con 
le mani umide o bagnate, il colore potrebbe cambiare o sbiadirsi.

 Non applicare etichette su persone, animali o piante. Inoltre, non applicare mai etichette in luoghi 
pubblici o privati, senza l'apposita autorizzazione.

 Poiché la fine del rotolo DK è studiata in modo tale da non aderire alla bobina di etichette, è possibile 
che l'ultima etichetta non venga tagliata correttamente. In tal caso, rimuovere le etichette rimanenti, 
inserire un nuovo rotolo DK e ristampare l'ultima etichetta.

Nota: considerando quanto sopra, il numero di etichette DK incluso in ciascun rotolo DK potrebbe essere 
superiore a quello indicato sulla confezione.

 Quando un'etichetta viene rimossa dopo essere stata applicata a una superficie, è possibile che una 
parte di essa resti attaccata.

 Prima di utilizzare etichette per CD/DVD, assicurarsi di seguire le istruzioni riportate nel manuale 
di istruzioni del lettore CD/DVD in merito all'applicazione di etichette CD/DVD.

 NON utilizzare etichette per i lettori CD/DVD con caricamento a fessura.

 NON rimuovere l'etichetta del CD/DVD dopo averla applicata sul CD/DVD, in quanto potrebbe staccarsi 
un piccolo strato superficiale, con conseguente danneggiamento del disco.

 NON applicare etichette CD/DVD ai dischi CD/DVD progettati per l'uso con stampanti a getto 
d'inchiostro. Le etichette si staccano facilmente da questo tipo di dischi e l'utilizzo di dischi con etichette 
staccate può provocare la perdita o il danneggiamento dei dati.

 Per applicare etichette per CD/DVD, utilizzare l'apposito applicatore incluso con le bobine di etichette 
CD/DVD. La mancata adozione di questo accorgimento potrebbe comportare il danneggiamento 
del lettore CD/DVD.

 Gli utenti saranno pienamente responsabili dell'applicazione delle etichette per CD/DVD. Brother non 
accetta alcuna responsabilità per la perdita o il danneggiamento dei dati provocato dall'uso improprio 
di etichette per CD/DVD.

 Fare attenzione a non lasciar cadere il rotolo DK.

 I rotoli DK utilizzano carta e pellicola termica. Sia le etichette che le stampe sbiadiscono in presenza 
di luce solare e calore.
Se si desidera preservare la durata, NON usare rotoli DK all'aperto.
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 A seconda dell'area, del materiale e delle condizioni ambientali, l'etichetta può non staccarsi o diventare 
irremovibile, il colore dell'etichetta può cambiare o essere trasferito su altri oggetti. Prima di applicare 
l'etichetta, controllare le condizioni ambientali e il materiale. Provare l'etichetta applicandone una piccola 
parte a un'area non appariscente della superficie desiderata.

 Se i risultati della stampa non rispondono alle aspettative, utilizzare le opzioni di regolazione nel driver 
stampante o nello Strumento di impostazione della stampante.

Precauzioni generali
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1
1

Descrizione dei componenti 1

Lato anteriore 1

Configurazione della stampante 
di etichette 1

1 Pulsante di avanzamento carta

2 Pulsante taglierina

3 Pulsante di alimentazione

4 LED di stato

5 Coperchio del vano del rotolo DK

6 Fessura di uscita delle etichette

2

4

31

5

6
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1
Lato posteriore 1

1 Porta USB

2 Porta di alimentazione CA

1
2
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1
Collegamento del cavo di alimentazione 1

Collegare il cavo di alimentazione CA alla stampante. Quindi, inserire il cavo di alimentazione CA in una 
presa elettrica.

IMPORTANTE

Non usare la stampante in aree in cui le tensioni di alimentazione sono diverse da quella specifica della 
stampante. Per dettagli sulla tensione corrispondente, vedere Specifiche del prodotto a pagina 55.
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1
Caricamento del rotolo DK 1

a Afferrare la stampante dal lato anteriore e sollevare con decisione il coperchio del vano del rotolo DK 
per aprirlo.

b Posizionare il rotolo DK nella guida della bobina portarotolo (1).
• Assicurarsi che il braccio della bobina portarotolo (2) sia inserito saldamente nella guida della bobina 

portarotolo.
• Accertarsi che lo stabilizzatore (3) scorra nella fessura della stampante.

1

2

3
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1
c Far scorrere il rotolo DK attraverso la stampante.

• Allineare il bordo del rotolo DK con il bordo verticale della fessura di uscita delle etichette.
• Controllare che il rotolo DK sia filettato in modo dritto così da evitare etichette storte.

• Far passare la prima etichetta attraverso la fessura di uscita delle etichette fino a che l'estremità non 
fuoriesce dalla fessura, come mostrato.

d Chiudere il coperchio del vano del rotolo DK.

IMPORTANTE

• Non lasciare le etichette stampate nella stampante. Così facendo, le etichette potrebbero incepparsi.

• Quando non in uso, rimuovere i rotoli DK dall'interno della stampante e chiudere il coperchio del vano del 
rotolo DK per prevenire la formazione di polvere e detriti nella stampante.
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1
Accensione/spegnimento 1

Accensione: premere il pulsante di alimentazione ( ) per accendere la stampante. Il LED di stato diventa 
verde.

IMPORTANTE

• Se è installata l'etichetta pretagliata DK, l'estremità dell'etichetta viene allineata automaticamente dopo 
aver premuto il pulsante alimentazione.

• Se è impostata un'etichetta diversa, premere il pulsante ( ) Alimentazione per allineare la fine 
dell'etichetta.

Spegnimento: premere e tenere premuto nuovamente il pulsante di alimentazione ( ) per spegnere 
la stampante.
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2
Installare il driver e il software della stampante su un 
computer 2

Per stampare da un computer Windows o Mac, installare il driver della stampante, P-touch Editor e altre 
applicazioni sul computer.

Software per Windows: 
Driver della stampante, P-touch Editor, P-touch Address Book, P-touch Update Software e Strumento 
di impostazione della stampante

Software per Mac: 
Driver della stampante, P-touch Editor, P-touch Update Software e Printer Setting Tool (Strumento 
di impostazione della stampante)

Nota
Se il computer non è collegato a Internet, vedere Installare il driver e il software della stampante su un 
computer non collegato a Internet a pagina 11.

a Visitare il sito Web install.brother e scaricare il programma di installazione del software e i manuali più 
recenti.

b Fare doppio clic sul file scaricato EXE (per Windows) o DMG (per Mac) e seguire le istruzioni a schermo 
per procedere con l'installazione.

c Al termine dell'installazione, chiudere la finestra di dialogo.

Collegamento della Stampante di etichette a un computer 2

È possibile collegare la stampante a un computer Windows o a un Mac usando un cavo USB.

a Prima di collegare il cavo USB, assicurarsi che la stampante sia spenta.

b Collegare il cavo USB alla porta USB sul retro della stampante, quindi al computer in uso.

c Accendere la stampante.

Stampa da un computer (P-touch Editor) 2

http://install.brother
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2

Stampa da un computer 2

Applicazioni disponibili 2

Per usare la stampante in modo efficace, è disponibile una serie di applicazioni e funzioni.

Per usare le applicazioni è necessario installare il driver della stampante.

Visitare il sito (install.brother) e scaricare il programma di installazione delle applicazioni e il driver della 
stampante.

Applicazione Windows Mac Funzioni

P-touch Editor r r
Consente di progettare e stampare etichette personalizzate 
con strumenti di disegno incorporati, scrivere usando font 
e stili diversi, immagini grafiche importate e codici a barre.

P-touch Library r

Consente di gestire e stampare modelli P-touch Editor.

Per stampare i modelli, è possibile utilizzare P-touch Library.

Viene installata con P-touch Editor.

P-touch Update Software r r Consente di aggiornare il software alla versione più recente.

P-touch Address Book r
Consente di stampare le etichette dell'indirizzo usando 
un database indirizzi.

Strumento 
di impostazione 
della stampante 
(Printer Setting Tool)

r r
Consente di specificare le impostazioni della stampante 
da un computer.

http://install.brother
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Creazione di etichette dal computer 2

Questa stampante consente di stampare in vari modi.

Di seguito viene descritta la procedura di stampa da un computer usando P-touch Editor o P-touch Address Book.

a Avviare P-touch Editor o P-touch Address Book, quindi aprire il documento da stampare.

b Creare un progetto di etichetta.

c Controllare le opzioni di taglio.

d Selezionare File > Stampa o fare clic sull'icona Stampa.

Opzioni di taglio 2

Le opzioni di taglio consentono di specificare in che modo viene fatto avanzare l'elemento e come viene 
tagliato durante la stampa. Usare il driver della stampante per selezionare l'opzione di taglio quando si stampa 
dal computer.

Taglio automatico Taglia alla fine Immagine

No Sì

No No

Sì Sì o No

ABCABC

ABCABC

ABC
ABC
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2

Applicazione di etichette 2

a Rimuovere il supporto dall'etichetta.

b Posizionare l'etichetta, quindi premere con decisione con un dito, dall'alto verso il basso, per applicare 
l'etichetta.

Nota
Le etichette si applicano con difficoltà alle superfici bagnate, sporche o non uniformi e potrebbero staccarsi 
facilmente da tali superfici.

Installare il driver e il software della stampante su un computer non collegato a 
Internet 2

a Su un computer collegato a Internet, visitare il sito support.brother.com, selezionare il modello e aprire 
la pagina Download.

b Selezionare il sistema operativo del computer non collegato a Internet.

c Scaricare i file desiderati. 

IMPORTANTE

Per utilizzare la stampante è necessario scaricare sul computer almeno il driver stampante e P-touch 
Editor.

Windows

• Non usare Software / Documenti installazione, in quanto esso richiede una connessione Internet 
attiva.

• Scaricare ciascun tipo di software individualmente, ad esempio: Driver della stampante o P-touch 
Editor.

Mac

Scaricare il Pacchetto software completo.

d Copiare il file EXE scaricato (per Windows) o il file DMG (per Mac) dalla cartella Download su un 
supporto rimovibile (ad esempio, un'unità flash USB o un CD-ROM).

e Copiare i file scaricati dal supporto rimovibile sul computer non collegato a Internet.

f Fare doppio clic sui file scaricati e seguire le istruzioni a schermo per procedere con l'installazione.

g Al termine dell'installazione, chiudere la finestra di dialogo.

http://support.brother.com
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3

Strumento di impostazione della stampante per Windows 3

Lo Strumento di impostazione della stampante consente di specificare le impostazioni di comunicazione della 
stampante, le impostazioni dei dispositivi e le impostazioni di P-touch Template da un computer Windows.

Nota
Lo Strumento di impostazione della stampante può essere installato mediante il programma di 
installazione di software/documentazione. Per ulteriori informazioni, vedere Installare il driver e il software 
della stampante su un computer a pagina 8.

Prima di usare lo Strumento di impostazione della stampante 3

 Accertarsi che il cavo di alimentazione CA sia collegato alla stampante e a una presa elettrica.

 Assicurarsi che il driver della stampante sia stato installato correttamente e che la stampa sia abilitata.

 Collegare la stampante a un computer tramite un cavo USB.

Modifica delle impostazioni della 
stampante di etichette 3
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3

Uso dello Strumento di impostazione della stampante 
per Windows 3

a Collegare al computer la stampante da configurare.

b Avviare lo Strumento di impostazione della stampante.

 Per Windows 7:

Fare clic su Start > Tutti i programmi > Brother > Label & Mobile Printer > Printer Setting Tool 
(Strumento di impostazione della stampante).

 Per Windows 8 / Windows 8.1:

Nella schermata App, fare clic su Printer Setting Tool (Strumento di impostazione della stampante). 

 Per Windows 10:

Fare clic su Start > Brother > Printer Setting Tool (Strumento di impostazione della stampante). 

Viene visualizzata la finestra principale.

1 Stampante
Elenca le stampanti collegate.

2 Impostazioni dispositivo
Specifica le impostazioni del dispositivo. Ad esempio, le impostazioni dell'alimentazione.

3 Esci
Chiude la finestra.

1

2

3
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c Controllare che la stampante da configurare sia presente accanto a Stampante. Se viene visualizzata 
una stampante diversa, selezionare la stampante desiderata dall'elenco a discesa.

d Consente di selezionare le impostazioni da modificare e specificare o modificare le impostazioni nella 
finestra di dialogo.
Per ulteriori informazioni sulle finestre di dialogo delle impostazioni, vedere Impostazioni dispositivo per 
Windows  a pagina 15.

e Fare clic su Applica per applicare le impostazioni alla stampante.

f Per completare la modifica delle impostazioni nella finestra principale, fare clic su Esci.

IMPORTANTE

Lo Strumento di impostazione della stampante deve essere utilizzato per configurare la stampante solo 
quando questa è in fase di standby. Se si tenta di eseguire la configurazione mentre è in corso la stampa 
di un lavoro, la stampante potrebbe non funzionare correttamente.
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Impostazioni dispositivo per Windows 3

Usare Impostazioni dispositivo in Strumento di impostazione della stampante per specificare o modificare 
le impostazioni della stampante quando si collegano la stampante e il computer con un cavo USB. È possibile 
non solo modificare le impostazioni dispositivo per una stampante, ma anche applicare facilmente le stesse 
impostazioni a più stampanti.

Quando si stampa da un'applicazione per computer, è possibile specificare diverse impostazioni di stampa dal 
driver stampante; tuttavia, se si utilizza l'opzione Impostazioni dispositivo dello Strumento di impostazione 
della stampante, è possibile specificare altre impostazioni avanzate.

Quando si apre Impostazioni dispositivo, vengono recuperate e visualizzate le impostazioni correnti della 
stampante. Se non è stato possibile recuperare le impostazioni correnti, vengono visualizzate le impostazioni 
precedenti. Se non è stato possibile recuperare le impostazioni correnti e le impostazioni precedenti non 
sono state specificate, vengono visualizzate le impostazioni predefinite della macchina.

Finestra di dialogo delle impostazioni 3

1 Barra dei menu
I comandi sono suddivisi in categorie in ogni menu (File, Manutenzione e Informazioni su...) in base alla 
loro funzione.

2 Stamp
Specifica la stampante da configurare.

1
2
3

4

5

6

7

8
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3 Schede delle impostazioni
Contengono impostazioni che possono essere specificate o modificate.

Nota

Se nella scheda è presente l'icona , le impostazioni contenute in tale scheda non possono essere 

modificate. Inoltre, le impostazioni della scheda non saranno applicate alla stampante anche se si fa clic 
su Applica. Inoltre, quando si utilizzano i comandi Salva nel file di comando o Esporta, le impostazioni 
specificate nella scheda non verranno salvate né esportate.

4 Impostazioni correnti
Recupera le impostazioni dalla stampante collegata correntemente e le visualizza nella finestra di dialogo. 

Le impostazioni saranno recuperate anche per i parametri sulle schede che presentano l'icona .

5 Disattiva queste impostazioni

Se si seleziona questa casella di controllo, nella scheda compare l'icona  e le impostazioni non 

possono essere più né specificate né modificate.

Le impostazioni di una scheda in cui è presente l'icona  non saranno applicate alla stampante, 

nemmeno facendo clic su Applica. Inoltre, quando si utilizza il comando Esporta, le impostazioni 
specificate nella scheda non verranno salvate né esportate.

6 Parametri
Visualizza le impostazioni correnti.

7 Esci
Consente di uscire da Impostazioni dispositivo e di tornare alla finestra principale di Strumento 
di impostazione della stampante.

8 Applica
Applica le impostazioni alla stampante.
Per visualizzare le impostazioni correnti, selezionare Verifica impostazione nell'elenco a discesa.
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Barra dei menu 3

Opzioni di menu File

• Applica impostazione alla stampante...

Applica le impostazioni alla stampante.

• Verifica impostazione

Visualizza le impostazioni correnti.

• Importa

Importa il file esportato.

• Esporta

Salva in un file le impostazioni correnti.

Opzioni di menu Manutenzione

Nota
Per visualizzare alcuni elementi è necessario disporre dei privilegi di amministratore del computer o della 
stampante. È possibile confermare i privilegi di amministratore per la stampante facendo clic nel menu 
Proprietà stampante e poi nella scheda Sicurezza.

• Ripristina sulle impostazioni di fabbrica

Ripristina le impostazioni di fabbrica del dispositivo nelle schede Base.

• Impostazioni opzioni

Se la casella di controllo Non visualizzare un messaggio di errore se le impostazioni correnti 
non possono essere recuperate all'avvio è selezionata, la volta successiva non verrà visualizzato 
un messaggio.

Scheda Base 3

• Accensione automatica

Specifica se la stampante si accende automaticamente quando il cavo di alimentazione CA viene collegato 
a una presa elettrica.

• Spegnimento automatico

Specifica il periodo di tempo che deve trascorrere prima che la stampante si spenga automaticamente.

• Stampa dati dopo aver stampato

Specifica se i dati di stampa vengono cancellati dopo la stampa.
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Applicazione delle modifiche delle impostazioni a più stampanti di etichette 3

a Dopo aver applicato le impostazioni alla prima stampante, scollegare la stampante dal computer 
e collegare la seconda stampante al computer.

b Selezionare la stampante collegata di recente dall'elenco a discesa Stamp.

c Fare clic su Applica. Le stesse impostazioni che erano state applicate alla prima stampante vengono 
applicate alla seconda.

d Ripetere i passaggi da a a c per tutte le stampanti di cui si desidera modificare le impostazioni.

Nota
Per salvare le impostazioni correnti in un file, fare clic su File > Esporta.

È possibile applicare le stesse impostazioni a un'altra stampante facendo clic su File > Importa 
e selezionando quindi il file delle impostazioni esportate. Per ulteriori informazioni, vedere Impostazioni 
dispositivo per Windows  a pagina 15.
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Printer Setting Tool per Mac 3

Printer Setting Tool (Strumento di impostazione della stampante) permette di specificare le impostazioni 
di comunicazione della stampante e le impostazioni del dispositivo da un Mac. È possibile non solo modificare 
le impostazioni dispositivo per una stampante, ma anche applicare facilmente le stesse impostazioni a più 
stampanti.

Nota
Lo Strumento di impostazione della stampante può essere installato mediante il programma di 
installazione di software/documentazione. Per ulteriori informazioni, vedere Installare il driver e il software 
della stampante su un computer a pagina 8.

Prima di usare lo Printer Setting Tool 3

 Accertarsi che il cavo di alimentazione CA sia collegato alla stampante e a una presa elettrica.

 Assicurarsi che il driver della stampante sia stato installato correttamente e che la stampa sia abilitata.

 Collegare la stampante a un computer tramite un cavo USB.

Uso di Printer Setting Tool per Mac 3

a Collegare al computer la stampante da configurare.

b Fare clic su Macintosh HD > Applicazioni > Brother > Printer Setting Tool (Strumento di impostazione 
della stampante) > Printer Setting Tool.app.
Viene visualizzata la finestra Printer Setting Tool (Strumento di impostazione della stampante).

c Controllare che la stampante da configurare sia presente accanto a Printer (Stampante). Se viene 
visualizzata una stampante diversa, selezionare la stampante desiderata dall'elenco popup.

d Selezionare una delle schede Impostazioni, quindi specificare o modificare le impostazioni desiderate.

e Fare clic sul Apply Settings to the Printer (Applica impostazione alla stampante) per applicare 
le impostazioni alla stampante.

f Fare clic su Exit (Esci).

IMPORTANTE

Printer Setting Tool (Strumento di impostazione della stampante) deve essere utilizzato per configurare 
la stampante solo quando questa è in fase di standby. Se si tenta di eseguire la configurazione mentre 
è in corso la stampa di un lavoro, la stampante potrebbe non funzionare correttamente.
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Finestra di dialogo delle impostazioni 3

1 Printer (Stampante)
Elenca le stampanti collegate.

2 Import (Importa)
Importa le impostazioni da un file.

3 Export (Esporta)
Salva in un file le impostazioni correnti.

4 Schede delle impostazioni
Contengono impostazioni che possono essere specificate o modificate.

5 Apply Settings to the Printer (Applica impostazione alla stampante...)
Applica le impostazioni alla stampante.

6 Factory Reset (Ripristina predefiniti)
Ripristina le impostazioni di fabbrica del dispositivo nelle schede Basic (Base).

7 Current Settings (Impostazioni correnti)
Recupera le impostazioni dalla stampante collegata correntemente e le visualizza nella finestra di dialogo.

8 Exit (Esci)
Chiude lo Printer Setting Tool (Strumento di impostazione della stampante).

1

2

3

4

5

6 7 8
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Scheda Basic (Base) 3

• Auto Power On (Accensione automatica)

Specifica se la stampante si accende automaticamente quando il cavo di alimentazione CA viene collegato 
a una presa elettrica.

• Auto Power Off (Spegnimento automatico)

Specifica quanto tempo trascorre prima che la stampante si spenga automaticamente quando è collegata 
a una presa elettrica.

• Print Data after Printing (Stampa dati dopo aver stampato)

Specifica se i dati di stampa vengono cancellati dopo la stampa.

Applicazione delle modifiche delle impostazioni a più stampanti di etichette 3

a Dopo aver applicato le impostazioni alla prima stampante, scollegare la stampante dal computer 
e collegare la seconda stampante al computer.

b Selezionare la stampante collegata di recente nell'elenco a discesa Printer (Stampante).

c Fare clic su Apply Settings to the Printer (Applica impostazione alla stampante).
Le stesse impostazioni che erano state applicate alla prima stampante vengono applicate alla seconda.

d Ripetere i passaggi da a a c per tutte le stampanti di cui si desidera modificare le impostazioni.

Nota
Per salvare le impostazioni correnti in un file, fare clic su Export (Esporta).

È possibile applicare le stesse impostazioni a un'altra stampante facendo clic su Import (Importa) 
e selezionando quindi il file delle impostazioni esportate. Per ulteriori informazioni, vedere Finestra di 
dialogo delle impostazioni a pagina 20.
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Per utilizzare la stampante di etichette con il computer è necessario installare P-touch Editor e il driver stampante.

Per informazioni sui driver e software più recenti, visitare il sito support.brother.com e accedere alla pagina 
Download del modello in uso.

Per Windows 4

Avvio di P-touch Editor 4

a Avviare P-touch Editor .

 Per Windows 7:

Fare clic su Start > Tutti i programmi > Brother P-touch > P-touch Editor 5.2 oppure fare doppio 
clic sull'icona di collegamento P-touch Editor 5.2 sul desktop.

 Per Windows 8 / Windows 8.1:

Fare clic su P-touch Editor 5.2 nella schermata App oppure fare doppio clic sull'icona P-touch 
Editor 5.2 sul desktop.

 Per Windows 10:

Fare clic su Start > P-touch Editor 5.2 in Brother P-touch oppure fare doppio clic sull'icona P-touch 
Editor 5.2 sul desktop.

b Quando si avvia P-touch Editor, selezionare se si desidera creare un nuovo layout o aprirne uno 
esistente.

Nota
Per modificare il comportamento di P-touch Editor all'avvio del programma, fare clic su Strumenti > Opzioni 
nella barra dei menu di P-touch Editor, per visualizzare la finestra di dialogo Opzioni. Sul lato sinistro, 
selezionare l'intestazione Generale, quindi l'impostazione desiderata nella casella di riepilogo Operazioni 
in Impostazioni di avvio. L'impostazione predefinita è Visualizza nuova vista.

Come usare P-touch Editor 4

http://support.brother.com/
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c Selezionare una delle opzioni visualizzate:

1 Per creare un nuovo layout, fare doppio clic su Nuovo layout oppure fare clic su Nuovo layout 
e quindi su →.

2 Per creare un nuovo layout usando un layout predefinito, selezionare un pulsante di categoria oppure 
selezionare un pulsante di categoria e poi fare clic su →.

3 Per collegare un layout predefinito a un database, selezionare la casella di controllo accanto 
a Connetti database.

4 Per aprire un layout esistente, fare clic su Apri.

2

1

3

4
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Stampa con P-touch Editor 4

 Modalità Express

Questa modalità consente di creare rapidamente layout contenenti testo e immagini.

Prima di stampare, configurare le impostazioni di stampa nella schermata Stampa. 
Per stampare, fare clic su File > Stampa nella barra dei menu oppure fare clic sull'icona Stampa. 

 Modalità Professional

Questa modalità consente di creare layout utilizzando un'ampia gamma di strumenti avanzati e opzioni.

Prima di stampare, configurare le impostazioni di stampa nella schermata Stampa. 
Per stampare, fare clic su File > Stampa nella barra dei menu oppure fare clic sull'icona Stampa (A).

Inoltre, è possibile fare clic sull'icona Stampa (B) per avviare la stampa senza modificare le impostazioni 
di stampa.

B

A
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 Modalità Snap

Questa modalità consente di catturare (interamente o in parte) il contenuto della schermata del computer, 
stamparlo come immagine e salvarlo per un utilizzo futuro.

a Fare clic sul pulsante di selezione della modalità Snap.
Viene visualizzata la finestra di dialogo Descrizione della modalità Snap.

b Fare clic su OK.
Viene visualizzata la palette della modalità Snap.
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Per Mac 4

Avvio di P-touch Editor 4

Fare doppio clic su Macintosh HD > Applicazioni e quindi sull'icona dell'applicazione P-touch Editor .

Nota
Se si utilizza un computer Mac, non è possibile trasferire alla stampante i dati delle etichette creati 
con P-touch Editor.

Quando si avvia P-touch Editor, selezionare se si desidera creare un nuovo layout o aprirne uno esistente.
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Modalità operative 4

 Modalità Standard

Questa modalità consente di creare etichette con testo e immagini.

La modalità Standard è composta dalle seguenti sezioni:

1 Barra degli strumenti

2 Ispezione etichette

3 Area connessione database

4 Ispezione oggetti

5 Finestra di layout

L'immagine può variare a 
seconda del modello in uso.

1

2

3 45
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Questa sezione descrive come creare in modo efficace le etichette dai contatti utilizzando P-touch Address 
Book. Le schermate possono variare in base al sistema operativo in uso.

(In alcune lingue, il modulo P-touch Address Book non è supportato.) 

Avvio di P-touch Address Book 5

a Avviare P-touch Address Book .

 Per Windows 7:

Fare clic su Start > Tutti i programmi > Brother P-touch > P-touch Address Book 1.3 oppure fare 
doppio clic sull'icona di collegamento P-touch Address Book 1.3 sul desktop.

 Per Windows 8 / Windows 8.1:

Fare clic su P-touch Editor 1.3 nella schermata App oppure fare doppio clic sull'icona P-touch 
Editor 1.3 sul desktop.

 Per Windows 10:

Fare clic su Start > P-touch Address Book 1.3 in Brother P-touch oppure fare doppio clic sull'icona 
P-touch Address Book 1.3 sul desktop.

b All'avvio di P-touch Address Book, viene visualizzata la finestra di dialogo Avvio, che consente 
di definire le impostazioni per creare nuovi contatti o importare contatti Outlook e dati nel formato CSV.

c Nella finestra di dialogo Avvio, specificare l'operazione di P-touch Address Book da eseguire e fare clic 
sul pulsante OK.

 Quando si seleziona Crea nuovo contatto, viene visualizzata la finestra di dialogo Nuovo contatto.

 Quando si seleziona Importa contatti da file CSV o Importa contatti da Outlook, è possibile 
importare i contatti in altri formati.

 Fare clic sul pulsante Apri Guida… per aprire i file della Guida di P-touch Address Book.
La Guida di P-touch Address Book fornisce informazioni dettagliate sulle funzionalità disponibili 
e spiega come utilizzare P-touch Address Book.

Come usare P-touch Address Book 
(solo Windows) 5
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 Finestra di layout 

La finestra di layout è composta dalle seguenti sezioni:

1 Barra dei menu
I comandi sono suddivisi in categorie in ogni menu (File, Modifica, Visualizza, Layout e Strumenti) 
in base alle loro funzioni.

2 Barra degli strumenti Standard
Fornisce un gruppo di comandi utilizzati di frequente (come Nuovo contatto, Modifica contatto, 
Trova o Stampa).

3 Barra degli strumenti di testo
Consente di impostare gli attributi del testo, come le dimensioni dei font e l'allineamento 
per la formattazione del testo. 

4 Vista di selezione dello stile del layout
Visualizza gli stili del layout memorizzati nella cartella.

5 Area di lavoro layout
Consente di visualizzare o modificare un layout che utilizza lo stile del layout nella finestra 
di selezione dello stile del layout.

6 Casella combinata dell'elenco di contatti
Visualizza l'elenco di contatti specificato correntemente. È possibile scegliere tra Personale, 
Lavoro, Altro1, Altro2 e Altro3.

1

2

3

4

6

8

5
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7 Scheda Indice
È possibile cercare all'interno del campo in Visualizza record. Fare clic su Strumenti > Ordina 
per aprire la finestra di dialogo Ordina e specificare il campo desiderato mediante Chiave1.

8 Visualizza record
Visualizza i dati di contatto in ciascun campo. I dati possono anche essere modificati (aggiunti, 
eliminati o aggiornati).

Creazione di un nuovo contatto 5

In questa sezione viene spiegato come creare un nuovo contatto.

a Fare clic su File > Nuovo contatto oppure fare clic sul pulsante Nuovo contatto .

Viene visualizzata la finestra di dialogo Nuovo contatto.

b Immettere le informazioni relative al nuovo contatto.

1

2
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1 Barra degli strumenti Nuovo contatto
Nel menu sono raggruppati i seguenti comandi:

2 Modulo dei contatti
Consente di immettere informazioni quali nome, indirizzo, numero di telefono, dati dell'azienda 
e indirizzo e-mail per il nuovo contatto.

c Dopo aver finito di immettere i dati, fare clic sul pulsante Salva e chiudi  per memorizzarli.

Icona Nome pulsante Funzione

Precedente Visualizza il contatto precedente.

Successivo Visualizza il contatto successivo.

Nuovo contatto Visualizza la finestra del modulo che consente di creare un 
nuovo contatto.

Elimina contatto Elimina il contatto attualmente selezionato.

Image Consente di inserire un'immagine per un contatto da un file 
o una fotocamera collegata al computer.

Sono supportati i seguenti tipi di file:

• Bitmap (*.bmp, *.dib)

• File JPEG (*.jpg, *.jpeg)

• File TIFF (non compressi) (*.tif)

• File GIF (*.gif)

• Icona (*.ico)

• Metafile Windows (*.wmf, *.emf) (La regolazione di immagini 
non è consentita.)

• File PNG (*.png)

Salva e chiudi Salva il contatto e chiude la finestra di dialogo Nuovo contatto.
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Questo programma consente di gestire e stampare i modelli P-touch Editor.

Avvio di P-touch Library 6

 Per Windows 7:

Fare clic su Start > Tutti i programmi > Brother P-touch > P-touch Tools > P-touch Library 2.3.

 Per Windows 8 / Windows 8.1:

Nella schermata App, fare clic su P-touch Library 2.3.

 Per Windows 10:

Fare clic su Start > P-touch Library 2.3 in Brother P-touch.

All'avvio di P-touch Library viene visualizzata la finestra principale.

Finestra principale 6

1 Barra dei menu
Consente di accedere a tutti i comandi disponibili, suddivisi a seconda del titolo del menu (File, Modifica, 
Visualizza, Strumenti e [?] (Guida)) in base alle rispettive funzioni.

2 Barra degli strumenti
Consente di accedere ai comandi di uso frequente.

3 Elenco cartelle
Visualizza un elenco di cartelle. Quando si seleziona una cartella, i modelli contenuti nella cartella 
selezionata vengono visualizzati nell'elenco modelli.

Come utilizzare P-touch Library 
(solo Windows) 6

2

3

1

4

5
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4 Elenco modelli
Visualizza un elenco di modelli nella cartella selezionata.

5 Anteprima
Visualizza un'anteprima dei modelli selezionati nell'elenco modelli.

Spiegazione delle icone della barra degli strumenti

Icona Nome pulsante Funzione

Apri Apre il modello selezionato.

Stampa Stampa il modello selezionato utilizzando la stampante.

Cerca Esegue la ricerca di modelli memorizzati in P-touch Library.

Stile visualizzazione Modifica lo stile di visualizzazione del file.
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Apertura e modifica dei modelli 6

Selezionare il modello da aprire o modificare, quindi fare clic su Apri.

Viene avviato il programma associato al modello ed è possibile modificare il modello.
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Stampa dei modelli 6

Selezionare il modello da stampare, quindi fare clic su Stampa.

La stampante collegata stampa il modello.
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Ricerca di modelli 6

È possibile eseguire la ricerca di modelli registrati in P-touch Library.

a Fare clic su Cerca.
Viene visualizzata la finestra di dialogo Cerca.

b Specificare i parametri di ricerca.
I parametri di ricerca disponibili sono i seguenti:

c Fare clic su Inizia ricerca.
Viene avviata la ricerca e vengono visualizzati i risultati della ricerca.

Impostazioni Dettagli

Parametri multipli Determina il metodo di ricerca nel caso in cui vengano specificate più condizioni. 
Se si seleziona E, vengono cercati i file che soddisfano tutte le condizioni. 
Se si seleziona O, vengono cercati i file che soddisfano una delle condizioni.

Nome Consente di cercare un modello in base al nome del file.

Tipo Consente di cercare un modello in base al tipo di file.

Dimensioni Consente di cercare un modello in base alle dimensioni del file.

Data Consente di cercare un modello in base alla data del file.
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d Chiudere la finestra di dialogo Cerca.
È possibile confermare i risultati della ricerca facendo clic su Risultati ricerca nella visualizzazione 
cartella.

Nota
È possibile registrare i modelli in P-touch Library trascinandoli e nella cartella Tutti i file o nell'elenco delle 
cartelle. Per configurare P-touch Editor in modo che i modelli vengano registrati automaticamente 
in P-touch Library, effettuare le seguenti operazioni:

1 Dal menu P-touch Editor, selezionare Strumenti > Opzioni.

2 Nella finestra di dialogo Opzioni, fare clic sull'opzione Generale > Impostazioni di registrazione.

3 Specificare quando devono essere registrati i modelli creati con P-touch Editor, quindi fare clic su OK.
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Il software può essere aggiornato alla versione più recente disponibile usando P-touch Update Software.

Nota
• Il software e i contenuti effettivi del manuale potrebbero variare.

• Non spegnere l'apparecchio durante il trasferimento dei dati o l'aggiornamento del firmware.

Aggiornamento di P-touch Editor e P-touch Address Book 
(solo Windows) 7

IMPORTANTE

Prima di aggiornare P-touch Editor e P-touch Address Book, installare il driver della stampante. 

a Avviare P-touch Update Software.

 Per Windows 7:

Fare doppio clic sull'icona P-touch Update Software.

Nota
Il seguente metodo può essere utilizzato anche per avviare P-touch Update Software:

Fare clic su Start > Tutti i programmi > Brother P-touch > P-touch Update Software.

 Per Windows 8 / Windows 8.1:

Fare clic su P-touch Update Software nella schermata App oppure fare doppio clic su P-touch 
Update Software sul desktop.

 Per Windows 10:

Fare clic su Start > Brother P-touch > P-touch Update Software o fare doppio clic su P-touch 
Update Software sul desktop.

Come aggiornare P-touch Software 7
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b Fare clic sull'icona Aggiornamento software computer.

c Selezionare un valore per Stampante e Lingua, poi selezionare le caselle di controllo accanto a P-touch 
Editor e P-touch Address Book, quindi fare clic su Installa.

d Viene visualizzato un messaggio che indica che l'installazione è terminata.
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Aggiornamento del firmware 7

IMPORTANTE

• Prima di aggiornare il firmware, è necessario installare il driver della stampante.

• Non spegnere l'apparecchio durante il trasferimento dei dati o l'aggiornamento del firmware.

• Se è in esecuzione un'altra applicazione, uscire dall'applicazione stessa.

Per Windows 7

a Accendere la stampante e collegare il cavo USB.

b Avviare P-touch Update Software.

 Per Windows 7:

Fare doppio clic sull'icona P-touch Update Software.

Nota
Il seguente metodo può essere utilizzato anche per avviare P-touch Update Software: 
Fare clic su Start > Tutti i programmi > Brother P-touch > P-touch Update Software.

 Per Windows 8 / Windows 8.1:

Fare clic su P-touch Update Software nella schermata App oppure fare doppio clic su P-touch 
Update Software sul desktop.

 Per Windows 10:

Fare clic su Start > Brother P-touch > P-touch Update Software o fare doppio clic su P-touch 
Update Software sul desktop.
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c Fare clic sull'icona Aggiornamento dispositivo.

d Selezionare Stampante, controllare che venga visualizzato il messaggio Il dispositivo è collegato 
correttamente., quindi fare clic su OK.
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e Selezionare un valore per Lingua, selezionare la casella di controllo accanto al firmware da aggiornare, 
quindi fare clic su Trasferisci.

IMPORTANTE

Durante il trasferimento dei dati, non spegnere la stampante e non scollegare il cavo.

f Controllare il contenuto da aggiornare, quindi fare clic su Avvia per avviare l'aggiornamento. 
L'aggiornamento del firmware viene avviato.

IMPORTANTE

Non spegnere la stampante e non scollegare il cavo durante il processo di aggiornamento.

Per Mac 7

a Accendere la stampante e collegare il cavo USB.

b Fare doppio clic su Macintosh HD > Applicazioni > P-touch Update Software e quindi fare doppio 
clic sull'icona dell'applicazione P-touch Update Software.
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c Fare clic sull'icona Aggiornamento dispositivo.

d Selezionare Stampante, controllare che venga visualizzato il messaggio Il dispositivo è collegato 
correttamente., quindi fare clic su OK.

e Selezionare un valore per Lingua, selezionare la casella di controllo accanto al firmware da aggiornare, 
quindi fare clic su Trasferisci.

IMPORTANTE

Durante il trasferimento dei dati, non spegnere la stampante e non scollegare il cavo.

f Controllare il contenuto da aggiornare, quindi fare clic su Avvia per iniziare l'aggiornamento. 
L'aggiornamento del firmware viene avviato.

Nota
Non spegnere la stampante durante il processo di aggiornamento.
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Se la stampante non funziona correttamente, reimpostare le impostazioni del dispositivo.

Ripristino delle impostazioni del dispositivo sui valori 
predefiniti di fabbrica mediante i pulsanti della stampante di 
etichette 8

Per reimpostare la stampante, eseguire le seguenti operazioni.

a Spegnere la stampante.

b Premere contemporaneamente il pulsante di alimentazione ( ) e il pulsante taglierina ( ) per circa due 
secondi. Il LED di stato si accende in arancione.

c Continuare a tenere premuto il pulsante di alimentazione ( ) e premere sei volte il pulsante taglierina ( ). 

d Rilasciare il pulsante di alimentazione ( ). Il LED di stato lampeggia in arancione. Dopodiché, il LED di 
stato si accende in verde.

Reimpostare le impostazioni del dispositivo tramite lo 
Strumento di impostazione della stampante 8

Inoltre, è possibile usare lo Strumento di impostazione della stampante dal computer per ripristinare le 
impostazioni del dispositivo sui valori di fabbrica.

Per ulteriori informazioni, vedere Ripristina sulle impostazioni di fabbrica a pagina 17.

Ripristino della stampante di etichette 8
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Consigliamo di pulire la stampante a cadenza regolare per garantire prestazioni sempre ottimali.

Nota
Scollegare sempre il cavo di alimentazione CA prima di pulire la stampante.

Pulizia delle parti esterne dell'unità 9

Rimuovere la polvere ed eventuali macchie dall'unità principale servendosi di un panno morbido e asciutto.

Per rimuovere i segni ostinati, utilizzare un panno leggermente bagnato con acqua.

Nota
Non usare diluenti, benzene, alcol o qualsiasi altro solvente organico.

Questi prodotti potrebbero danneggiare la custodia esterna della stampante.

Pulizia dell'uscita delle etichette 9

Se un'etichetta provoca l'inceppamento della macchina a causa della colla attaccata sulla fessura di uscita 
delle etichette, scollegare il cavo di alimentazione CA dalla macchina e pulire con un panno o bastoncino di 
cotone imbevuto di alcol isopropilico o etanolo.

Nota
Utilizzare alcol isopropilico o etanolo in conformità alle linee guida di sicurezza del produttore, se 
applicabili.

Pulizia automatica della testina di stampa 9

Il rotolo DK (carta termica) utilizzato con la macchina è studiato per pulire automaticamente la testina di stampa. 
Quando il rotolo DK oltrepassa la testina di stampa durante la stampa e l'avanzamento di etichette, la testina 
di stampa viene pulita.

Manutenzione 9
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Panoramica 10

In questo capitolo è spiegato come risolvere i problemi tipici che si possono verificare durante l'utilizzo della 
stampante di etichette. Se si riscontrano problemi con la stampante, controllare dapprima di avere eseguito 
le seguenti operazioni in modo corretto.

 Collegare la stampante a una presa elettrica. Per ulteriori informazioni, vedere Collegamento del cavo 
di alimentazione a pagina 4.

 Rimuovere tutto l'imballaggio di protezione dalla stampante.

 Installare e selezionare il driver della stampante corretto. Per ulteriori informazioni, vedere Installare il driver 
e il software della stampante su un computer a pagina 8.

 Collegare la stampate a un computer. Per ulteriori informazioni, vedere Collegamento della Stampante di 
etichette a un computer a pagina 8.

 Chiudere completamente il coperchio del vano del rotolo DK.

 Inserire correttamente un rotolo DK. Per ulteriori informazioni, vedere Caricamento del rotolo DK a pagina 5.

Se i problemi persistono, leggere i consigli sulla risoluzione dei problemi contenuti in questo capitolo. Se, 
dopo aver letto questo capitolo, non si riesce a risolvere il problema, visitare il sito web di supporto Brother 
alla pagina support.brother.com 

Problemi di installazione del driver (per Windows) 10

Risoluzione dei problemi 10

Problema Soluzione

Sul computer compare un 
messaggio del tipo "Il software del 
driver del dispositivo non è stato 
installato con successo".

• Sebbene messaggi di Windows di questo tipo possano continuare a 
comparire durante l'installazione, è comunque possibile installare 
correttamente il driver utilizzando il programma di installazione.

• Prima di eseguire il programma di installazione, assicurarsi che la 
stampante sia accesa e che sia collegata al computer con un cavo USB.

• Se il driver della stampante non è installato con successo, passare a Non 
si riesce a installare il driver della stampante anche se si segue la procedura 
corretta. a pagina 48.

• Non si riesce a installare il driver 
della stampante anche se si 
segue la procedura corretta.

• Non si riesce a vedere la 
stampante elencata in P-touch 
Editor anche se il driver della 
stampante è stato installato.

Se non si riesce a utilizzare la stampante anche se è stato installato il driver 
della stampante:

1 Scaricare il programma di disinstallazione del driver della stampante da 
support.brother.com 

2 Usare il programma di disinstallazione del driver della stampante per 
rimuovere le informazioni sulla stampante.

3 Eseguire di nuovo il programma di installazione e attenersi alle istruzioni a 
schermo per procedere con l'installazione.

http://support.brother.com/
http://support.brother.com/
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Indicazioni dei LED 10

Gli indicatori si illuminano e lampeggiano per segnalare lo stato della stampante.

 o  o Indicatore illuminato nel colore mostrato

 o  o Indicatore lampeggiante nel colore mostrato

L'indicatore è spento

LED di stato Condizione

L'alimentazione è DISATTIVATA.

Modalità di standby.

Modalità di avanzamento carta.

Modalità di stampa.

Modalità di taglio.

Ricezione dati.

Eliminazione del lavoro di stampa.

Il coperchio del vano del rotolo DK è aperto. Chiudere correttamente il coperchio del vano 
del rotolo DK.

La stampante è in modalità Reimposta.

Per ulteriori informazioni, vedere Ripristino delle impostazioni del dispositivo sui valori 
predefiniti di fabbrica mediante i pulsanti della stampante di etichette a pagina 46.

Se il LED di stato si accende in arancione per 0,5 secondi dopo la stampa, significa che la 
stampante sta cancellando tutti i dati di stampa.

Per ulteriori informazioni, vedere Uso dello Strumento di impostazione della stampante 
per Windows  a pagina 13 o Uso di Printer Setting Tool per Mac a pagina 19.

(Una volta per 
0,5 secondi)

La stampante è in modalità di raffreddamento.

Le impostazioni della stampante vengono ripristinate.

Per ulteriori informazioni, vedere Ripristino delle impostazioni del dispositivo sui valori 
predefiniti di fabbrica mediante i pulsanti della stampante di etichette a pagina 46.

La stampante è in modalità di avvio.

Provare ad aggiornare il firmware.

Per ulteriori informazioni, vedere Aggiornamento del firmware a pagina 41.

Se la stampante è ancora in modalità di avvio, contattare l'Assistenza clienti Brother.

(Una volta per 
2 secondi)

Errore fine rotolo.

Errore di supporto esaurito.

Errore di supporto errato.

Errore di avanzamento carta.

Errore di apertura del coperchio.

Errore dati trasferiti.
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Problemi di stampa 10

(Due volte per 
2 secondi)

Errore taglierina.

(Lampeggia 
velocemente)

Errore di sistema.

Contattare il Servizio clienti Brother.

Problema Soluzione

Il LED di stato non si accende. Il cavo di alimentazione CA è inserito correttamente? 
Controllare che il cavo di alimentazione CA sia inserito. Se il cavo è inserito 
correttamente, provare a collegarlo a un'altra presa elettrica.

La stampante non stampa, oppure 
si verifica un errore di stampa.

• Il cavo si è allentato?
Controllare che il cavo sia collegato correttamente.

• Il rotolo DK è installato correttamente?
In caso negativo, rimuovere il rotolo DK e reinstallarlo.

• È rimasta una quantità di rotolo sufficiente?
Controllare che sia rimasta una quantità di rotolo sufficiente.

• Il coperchio del vano del rotolo DK è aperto?
Controllare che il coperchio del vano del rotolo DK sia chiuso.

• Si è verificato un errore di stampa o trasmissione?
Spegnere e riaccendere la stampante. Se il problema persiste, 
contattare il Servizio clienti Brother.

• Se la stampante è collegata tramite un hub USB, provare a collegarla 
direttamente al computer. In caso contrario, provare a collegarla a 
un'altra porta USB.

L'etichetta stampata contiene strisce o 
caratteri di bassa qualità oppure 
l'avanzamento dell'etichetta è errato.

La testina di stampa o il rullo sono sporchi?
Anche se generalmente la testina di stampa resta pulita durante l'uso 
normale, è possibile che della lanugine o della sporcizia provenienti dal rullo 
rimangano attaccati alla testina di stampa.
In tal caso, pulire il rullo.
Per ulteriori informazioni, vedere Pulizia automatica della testina di stampa 
a pagina 47.

Nel computer viene visualizzato 
un messaggio di errore di trasmissione 
dei dati.

La stampante è in modalità raffreddamento (il LED di stato lampeggia 
in arancione)?
Attendere che il LED di stato smetta di lampeggiare, quindi provare 
nuovamente a stampare.

Le etichette sono inceppate nella 
taglierina.

Contattare il Servizio clienti Brother.

LED di stato Condizione



Risoluzione dei problemi 

51

10

L'etichetta non viene espulsa 
correttamente dopo la stampa.

• Verificare che la fessura di uscita delle etichette non sia bloccata.

• Controllare che il rotolo DK sia impostato correttamente: per farlo, 
rimuovere il rotolo DK e reinstallarlo.

• Verificare che il coperchio del vano del rotolo DK sia chiuso 
correttamente.

Si desidera annullare il lavoro di stampa 
corrente.

Assicurarsi che la stampante sia accesa e premere una volta il pulsante 

alimentazione ( ).

La qualità di stampa è bassa. Nel rullo è presente sporcizia o lanugine, che ne impediscono il libero 
movimento? 
Per ulteriori informazioni, vedere Pulizia automatica della testina di stampa 
a pagina 47.

Dopo aver sostituito il rotolo mentre 
il componente aggiuntivo era attivato, lo 
stile del layout non è stato aggiornato.

Chiudere P-touch Editor per uscire dal componente aggiuntivo, quindi 
riattivarlo.

L'icona del componente aggiuntivo 
P-touch non è visualizzata in Microsoft 
Word.

• Microsoft Word è stato avviato da Microsoft Outlook?

• Microsoftt Word è stato scelto come editor predefinito per 
Microsoft Outlook?
A causa delle limitazioni del programma, il componente aggiuntivo 
Microsoft Word non funziona con le impostazioni di cui sopra. Chiudere 
Microsoft Outlook e riavviare Microsoft Word.

La stampante è in modalità 
raffreddamento.

La temperatura della testina di stampa termica è troppo elevata.

La stampante interrompe la stampa e la riprende solo dopo che la testina 
termica si è raffreddata. La testina si surriscalda se si stampa un numero 
elevato di etichette.

Se la testina termica si surriscalda, potrebbe generare immagini al di fuori 
dell'area di stampa. Per evitare o tardare il surriscaldamento, accertarsi che 
la stampante sia soggetta ad adeguata ventilazione e non sia posizionata 
in uno spazio ristretto.

Se la stampante si deve raffreddare perché si è surriscaldata a causa del 
tipo di rotolo DK in uso o del contenuto dell'etichetta, la stampa potrebbe 
durare più del previsto.

Nota
Questa condizione può presentarsi più frequentemente quando si 
utilizza la stampante ad altitudini elevate (oltre i 3048 metri), in quanto il 
raffreddamento della stampante avviene in presenza di aria di minore 
densità.

Errore taglierina. Se si verifica un errore della taglierina, tenere chiuso il coperchio del vano 
del rotolo DK e premere il pulsante di alimentazione ( ). La taglierina torna 
nella posizione normale e la stampante si spegne automaticamente.
Dopo lo spegnimento della stampante, controllare la fessura di uscita 
delle etichette e rimuovere eventuali etichette incastrate. Contattare il 
Servizio clienti Brother.

Problema Soluzione
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Impossibile rimuovere un errore. Per rimuovere un errore:

1 Aprire il coperchio del vano del rotolo DK, quindi richiuderlo.

2 Se l'errore non viene rimosso, premere il pulsante taglierina ( ).

3 Se l'errore non viene rimosso, spegnere e accendere nuovamente 
la stampante.

4 Se l'errore non è ancora stato rimosso, contattare il Servizio clienti 
Brother.

Si desidera reimpostare la stampante. È possibile reimpostare la stampante utilizzando lo Strumento di 
impostazione della stampante tramite un computer.

Per ulteriori informazioni, vedere Modifica delle impostazioni della 
stampante di etichette a pagina 12.

È possibile reimpostare la stampante utilizzando i pulsanti sulla stampante.

Si desidera reimpostare la stampante. Per ulteriori informazioni, vedere Ripristino delle impostazioni del 
dispositivo sui valori predefiniti di fabbrica mediante 
i pulsanti della stampante di etichette a pagina 46.

Problema Soluzione
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La lettura dei codici a barre stampati 
risulta impossibile.

 Stampare le etichette in modo tale che i codici a barre siano allineati con 
la testina di stampa, come illustrato qui di seguito:

1 Testina di stampa

2 Codici a barre

3 Orientamento di stampa

 Se le loro dimensioni vengono ridotte o ingrandite, i codici a barre 
potrebbero non essere leggibili.

 Provare a usare un altro scanner.

 Consigliamo di stampare il codice a barre con le opzioni della qualità 
di stampa impostate su Assegna priorità alla qualità di stampa. 

Per Windows 7:

Per visualizzare le opzioni di Qualità, aprire le proprietà della stampante 
facendo clic sul pulsante Start > Dispositivi e stampanti, facendo quindi 
clic con il pulsante destro del mouse sulla stampante da impostare e 
facendo quindi clic su Preferenze stampa.

Per Windows 8 / Windows 8.1:

Per visualizzare le opzioni di Qualità, aprire le proprietà della stampante 
facendo clic su Pannello di controllo nella schermata App > Hardware 
e suoni > Dispositivi e stampanti, facendo clic con il pulsante destro del 
mouse sulla stampante da impostare e facendo quindi clic su Preferenze 
stampa.

Per Windows 10:

Per visualizzare le opzioni di Qualità, aprire le proprietà della stampante 
facendo clic sul pulsante Start > Impostazioni > Dispositivi > Stampanti 
e scanner > Dispositivi e stampanti, facendo quindi clic con il pulsante 
destro del mouse sulla stampante da impostare e facendo quindi clic 
su Preferenze stampa.

Per Mac:

Per cambiare le opzioni relative alla qualità di stampa, aprire la finestra 
di dialogo Stampa e nel menu pop-up con le opzioni di stampa, selezionare 
Basilare. 

Problema Soluzione

1

2

3
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Informazioni sulla versione 10

Problema Soluzione

Non si conosce il numero di versione 
del firmware per la stampante.

Per verificare il firmware più recente:

1 Accendere la stampante.

2 Premere e tenere premuto il pulsante taglierina ( ) per diversi secondi 
per stampare il rapporto.

È consigliabile usare un rotolo DK da 62 mm.

Si desidera verificare se si sta 
usando la versione più recente 
del software.

Usare P-touch Update Software per verificare di disporre della versione 
più recente.

Per ulteriori informazioni su P-touch Update Software, vedere Come aggiornare 
P-touch Software a pagina 39.
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Specifiche della stampante di etichette 11

Ambiente operativo 11

Specifiche del prodotto 11

Elementi Specifiche

Display LED di stato (verde, arancione, rosso)

Stampa

Metodo di stampa Stampa termica diretta tramite testina termica

Velocità di stampa Max. 71 mm/sec, max. 44 etichette/min. (Etichette di 
indirizzi standard) (Quando la stampante è collegata 
al PC e si usa P-touch Editor)

Testina di stampa 300 dpi/720 punti

Larghezza di stampa 
massima

59 mm

Lunghezza di stampa max. 1 m

Lunghezza di stampa min. 12,7 mm

Taglierina Taglierina automatica a lunga durata

Pulsanti Pulsante Alimentazione ( ), Pulsante Avanzamento ( ), pulsante Taglierina ( )

Interfaccia USB

Alimentazione 220 V-240 V CA, 50/60 Hz, 1,1 A

Dimensioni (L × P × A) 128 × 221 × 153 mm

Peso Circa 1,1 kg (senza rotoli DK)

Elementi Specifiche

Temperatura di funzionamento Da 10 a 35 °C

Umidità di funzionamento Dal 20 all’80% (senza condensa)
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È possibile utilizzare questa macchina per stampare direttamente da vari software Windows, installando il 
driver della stampante.

IMPORTANTE

Poiché le dimensioni foglio per questa macchina sono diverse da quelle della maggior parte delle altre 
stampanti, la stampa potrebbe non essere possibile anche dopo l'installazione del driver e del software, a 
meno che tale software non consenta di impostare le dimensioni corrette delle etichette. 

Impostazione del driver della stampante 12

I nomi delle stampanti nelle seguenti schermate potrebbero essere diversi dal nome della propria stampante.

Le schermate possono variare a seconda del modello di stampante o del sistema operativo.

a Aprire la finestra Dispositivi e stampanti.

 Per Windows 7:

Fare clic sul menu Start > Dispositivi e stampanti.

 Per Windows 8 / Windows 8.1:

1 Sulla schermata del desktop, spostare il cursore sull'angolo superiore o inferiore destro. Sul bordo 
destro della schermata del desktop sarà visualizzata la barra dei menu.

Nota
Se sullo schermo del computer è visualizzata la schermata di avvio, fare clic sul riquadro del desktop nella 
schermata di avvio.

2 Fare clic su Impostazioni > Pannello di controllo > Hardware e suoni > Dispositivi e stampanti.

 Per Windows 10:

1 Fare clic/fare clic con il pulsante destro del mouse (per l'operazione di tocco, toccare e tenere 
premuto) Start sul desktop.

2 (Sistema Windows >) Pannello di controllo > Hardware e suoni > Dispositivi e stampanti.

Nota
Per ulteriori informazioni, consultare la Guida di Windows.

b Selezionare "Brother QL-XXX" (dove "XXX" è il nome della stampante), fare clic con il pulsante destro 
del mouse e selezionare Selezionare la preferenze di stampa. Viene visualizzata la finestra di dialogo 
Preferenze stampa - Brother QL-XXXX.

c Selezionare le impostazioni desiderate e fare clic su OK. È possibile impostare il formato della carta, il 
numero di copie, la qualità e l'opzione di taglio.

Stampa diretta da altro software Windows12
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Scheda Base 12

È possibile impostare il formato della carta, il numero di copie, la qualità e l'opzione di taglio.

Scheda Avanzate 12

È possibile impostare le opzioni grafiche ("Mezzi toni", "Luminosità" e "Contrasto") e "Formato nastro 
continuo".

È possibile cambiare il formato dell'etichetta o creare un nuovo formato di etichetta dalla finestra di dialogo 
Formato nastro continuo che appare facendo clic su Impostazioni...
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È possibile impostare il nome del formato ("Nome") e il formato ("Larghezza", "Lunghezza" e 
"Alimentazione"), quindi fare clic su Predefinito.

Scheda Altro 12

È possibile modificare il valore dell'unità di misura, ("mm" o "pollici").



Stampa diretta da altro software Windows 

59

12

Stampa da altro software Windows 12

Per stampare da altri software Windows è necessario seguire le istruzioni riportate di seguito.

Le modalità di funzionamento possono variare a seconda del software.

IMPORTANTE

Poiché il formato della carta di questa macchina è diverso da altre stampanti normali, questa stampante 
potrebbe non fornire risultati ottimali.

a Selezionare "Brother QL-XXX" (dove "XXX" è il nome della stampante in uso) nelle impostazioni della 
stampante dell'applicazione.

b Regolare l'impostazione del formato carta in base alle dimensioni del rotolo DK impostato nella 
stampante.
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